1. Introduction

The aim of this document is to provide a detailed manual for a GIS-based case study to be used by Undergraduate students and others. The title and subject matter of the study is; 'Modelling Site Suitability for Wind Farms'. However the case study is by definition generic and it is hoped that some of the methodological and project management approaches used here could be just as easily applied in other GIS application areas that have site identification as their primary aim.

The focus of the case study is on an assessed piece of work, which will account for a 100% coursework proportion of a Level 2 Geographical Information Systems (GIS) Module taught at the University of Brighton. The idea is to carry out a series of guided workshops with students over an initial three week period which will introduce the users to the context, aims and objectives of the case study in a linked set of lectures and workshops. They will then be given a period of time (four further weeks) to carry out the study and produce a final report which will identify in any given geographical area, a number of potential sites for wind farms. Outputs will be in the form of maps, tables and diagrams. Because students will be free to choose their own geographical area for study (initially restricted to the South-East of England) there will be a variety of different outcomes. Each however will be assessed against the same set of criteria based on process, method, GIS knowledge and accuracy of the final analysis.

Although the Case Study is set as a 7-week block within a 13-week teaching module, this is by no means set in stone. From a teaching assessment point of view, the nature and length of the task can be altered to fit other teaching modes such as term structures and intensive or extensive learning frameworks. This might give students more time to carry out specific tasks or attach some additional modelling at the end to give the case study a longer time-span. Some suggestions on how to lengthen the case study will be listed in Chapter 5 Results and Outcomes.

The manual reproduced here will also contain appropriate written support as well as links to other available resources required for the completion of the case study.
e-Map Scholar Case Study 2001-02 funded by JISC & EDINA.

Students will also by definition be required to use OS digital maps from DIGIMAP and incorporate them with other sources.
1.1 Aims & Objectives

The principal aim is to set students a case study that tests and develops their skills within an applied GIS environment. The objectives are for students to become familiar with project management within a GIS and to develop their skills in the areas of data collection, transfer, collation and analysis.

The case study will combine topographic, social and wind speed data and place it within a criteria-based decision-making context. This process will serve as a useful model of best practice for wider GIS-based modelling in students other work.

Timetable:

This will be in the form of a 3-week lecture series, three workshops and then four self-study weeks leading to a written report.

Data Sets & Materials

Digimap Data for 4 Meridian tiles (20 X 20km).
Digimap Data for 2 broadly coterminous Panorama tiles (20 X 20 km).
DETR Wind Speed Database Programme (zipped copy of executable program supplied)
Ward Boundary Map of the South-East Region. (supplied)
Map of SSSI's in the South East (supplied)
ArcView v3.2
Excel or any other basic spreadsheet package

Learning Outcomes

Improved skills in;

- Data Downloading
- Data Collation
- Digital Map Data & OS Grid knowledge
- Wind Speed Modelling
- GIS Analysis
• Project Management.

General & Specific Skills learned in the Case Study

<table>
<thead>
<tr>
<th>GENERAL</th>
<th>SPECIFIC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Collation</strong></td>
<td>• Data Downloading (DIGIMAP)</td>
</tr>
<tr>
<td></td>
<td>• Data Conversion(MapManager Schemas)</td>
</tr>
<tr>
<td></td>
<td>• Understand OS Grid structure</td>
</tr>
<tr>
<td><strong>Data Entry</strong></td>
<td>• Adding columnar data (Add event theme)</td>
</tr>
<tr>
<td></td>
<td>• Joining tables</td>
</tr>
<tr>
<td></td>
<td>• Vector to Raster conversion (&amp; vice versa)</td>
</tr>
<tr>
<td><strong>Data Analysis</strong></td>
<td>• Buffering</td>
</tr>
<tr>
<td></td>
<td>• Querying</td>
</tr>
<tr>
<td></td>
<td>• Boolean file management</td>
</tr>
<tr>
<td></td>
<td>• Point Interpolation</td>
</tr>
<tr>
<td></td>
<td>• Surface Modelling</td>
</tr>
<tr>
<td></td>
<td>• Viewshed Modelling</td>
</tr>
<tr>
<td></td>
<td>• Scripting</td>
</tr>
<tr>
<td></td>
<td>• GeoProcessing Wizard</td>
</tr>
<tr>
<td><strong>Data Output</strong></td>
<td>• Layouts</td>
</tr>
<tr>
<td></td>
<td>• Exporting tabular data</td>
</tr>
<tr>
<td></td>
<td>• Exporting graphics files</td>
</tr>
</tbody>
</table>

Assessment & Timetable

Case Study Report including text, maps, flow-charts and tabular outputs.
(worth 100% of total module mark)

<table>
<thead>
<tr>
<th>WEEK</th>
<th>DATE</th>
<th>TOPIC</th>
<th>STAFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>15 April</td>
<td>Introduction to Case Study</td>
<td>RF</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Workshop 1</em></td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td>8</td>
<td>22 April</td>
<td>Case Study 1</td>
<td>RF</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Workshop 2</em></td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td>9</td>
<td>29 April</td>
<td>Case Study 2</td>
<td>RF</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Workshop 3</em></td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td>10</td>
<td>6 May</td>
<td>Self-directed practical on Case Study</td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No Lecture</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>13 May</td>
<td>Self-directed practical on Case Study</td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No Lecture</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>20 May</td>
<td>Self-directed practical on Case Study</td>
<td>NB/RF/NC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No Lecture</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>27 May</td>
<td>Assessment</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>HANDING - IN DATE FRIDAY MAY 31ST</em></td>
<td></td>
</tr>
</tbody>
</table>
2. Context

2.1 Wind Power: A Bright Potential for Renewable Energy

Wind Power remains one of the few bright spots in renewable energy in the 21st Century. Several European countries, in particular Denmark, produce a high percentage of their energy from wind power. Current share of energy production in Denmark is around 15% with a not unrealistic aim of producing 50% of Denmark's energy need from wind farms by 2030. Although the wind energy proportion of energy produced in the United Kingdom is only 0.4%, the country has one of the highest average wind speeds in Europe and has as a result, a vast potential for the development of wind energy as a renewable energy source (see Fig. 1 below). Many of the criteria necessary for the development of wind energy are met in the UK and it is only a combination of conservatism, investment and conservation considerations, which prevent it's extended development.

Wind power is typically generated by a number of large wind turbines. These range from 50 to 100 metres high and are generally gathered together in numbers to create a 'wind farm'. The siting of a wind farm is a significant initial step in the process of developing wind energy and it is this part of the process that will be the real focus of the case study. Some comment will be made on the context and environmental issues surrounding wind farm development but the advantage from a GIS point of view is it presents a very coherent setting for a decision-making cases study, which has a fundamentally 'geographical' context.

The object of this study is to apply selective parts of the initial phase of the British Wind Energy Association planning process for developers, to a target area in the South East region of the United Kingdom. The planning guidelines are an advice tool to assist the developer and local council to “…foster appropriate and commendable wind energy development.” They are voluntary, with no enforcement except when the developer presents a proposal to the local planning committee or the Secretary of State for the Environment and a public enquiry is instigated on behalf of the local population.
The importance of increasing the number of wind farms in the United Kingdom is displayed in the current government’s response to the Kyoto Summit on the Environment. To reduce environmentally damaging and ozone depleting emissions, the power generating companies are required to produce 10% of the total power capacity by 2010, from non-fossil fuel renewable resources. There is the requirement that 26% of this will come from onshore wind generation.
The typical Wind Energy turbine has a tower ranging from 50 to 100 metres high, with a set of two or three rotating blades attached to a hub containing a gearbox and turbine generator connected to the national power grid. It is necessary to, “…group wind turbines together so that they are financially and practically viable and to minimise their environmental impact.” (Brocklehurst 1999). These wind farms can stretch for several kilometres across the countryside, but provide locally produced electricity for large local communities.

There is currently a power ‘shortage’ in the South-East of England and with a concentration of wind farm development in the South West of the United Kingdom (most viable, high wind speeds). There is increasing pressure on developers to find ways of economically developing the lower wind speed sites. This pressure translates into the developers widening the scope of their search for potential sites, with the South East as a target region required to provide 6% of the total onshore wind resource. The development process requires the combination of technology and the landscape through a broad initial study eventually focusing onto a ‘shortlist of sites’.

The aim of the study can be to fix a maximum generation capacity and search for a suitable site that fulfils these criteria. Within the GIS Case Study this will provide the opportunity to examine two separate routes to identify suitable sites. Essentially the Case Study will be carried out in two phases. **Phase I** will expect the student to take an INITIAL CRITERIA (IC) approach and then re-work the process using a MODIFIED CRITERIA (MC) approach. These processes will be explained in more detail below. **Phase II** will then carry out further modelling on the selected sites by applying additional technical and environmental specification to help identify optimal site location(s).

### 2.2 GIS Issues, Sources & Materials

The Case Study will employ a rich mix of resources and materials. These will include GIS software, digital maps, wind speed modelling programmes and technical documentation associated with wind farms. The aim is to make sure that GIS Students will use a variety of skills to build up the required files in ArcView to do the modelling. The base data will be derived from DIGIMAP and the ETSU NOABL
Wind Speed Programme. The materials will be put together in a structured way and the sequence of development is outlined in the subsequent chapters. The first phase is to identify key criteria associated with Wind Farm location modelling. These criteria will be standard but there is no guarantee that they will produce matched outcomes in different areas of the South-East.

The second and third phases are key elements of all GIS projects, namely data identification & collection and data collation to get the collected data into a form usable within the GIS. These are major elements of the case study and the time required to complete these should not be underestimated. The data identification phase will involved students using their knowledge of the UK National Grid to download the appropriate digital map tiles from digimap as well as using the same knowledge to identify matching data from the wind speed model. The precise digital map base and layers to be downloaded and converted (through MapManager) will be made clear in the section on criteria. Once downloaded the data must be matched and converted through natural geo-processing.

At this stage all of the different layers required will be ready to be saved in a project in the GIS. The modelling stage will involve further transformation which will test student skills in key GIS analytical tasks such as querying, buffering, interpolation, surface modelling, boolean operations and scenario modelling. Provided the base layers have been correctly put together then a number of options can be tested based on the technical specification of wind farm modelling to produce a series of scenarios. This may optionally involve a number of other GIS operations such as cookie-cutting, viewshed modelling, scripting and vector data analysis. These will produce outcomes based on local demographic data to give the project an economic and social dimension to add to the technical specifications. It is not expected that there will be a single answer or single site identified. Part of the value of the exercise is to teach students that a GIS is best placed to produce a series of optional outcomes, which can then be explored further outside of the system to come up with appropriate locational decisions. The power of GIS and indeed geography is that we can model a vast number of locational decisions in a simple and fast system that greatly speeds up the process and allows the decision-maker to experiment with different options without slowing them down too much.
3. GIS Data Management

3.1 Stage 1: Key Criteria

The framework for the project has already been established, with the selected adoption of parts of Phase one of the BWEA ‘Best Practice Guidelines for Wind Energy Development’ (BWEA 1994). To find and test the suitability of sites, the developer must consider two separate sets of criteria or factors. The guidelines present the initial site selection phase with components from two broad areas, Technical and Environmental. The Criteria from these are broad in scope. The Technical criteria concentrate on a number of elements linked to modelling approximate wind speeds, topographic site conditions and accessibility. The Environmental criteria include landscape considerations, planning restrictions and proximity/visibility factors associated with local populations. It is stated that, “…all…elements are inter-related and they should be considered as having an important influence on each other” (BWEA 1994) suggesting that the criteria should be applied together when the developer is carrying out initial and modified modelling assessment of potential sites.

Both Technical and Environmental criteria will be used together in carrying out the IC and MC phases of the project. It is likely that the initial IC approach will use all listed criteria. It is then up to the student to decide (with some technical justification) as to which criteria to exclude in a modified MC phase. A key concept that applies to IC suggests that the developer should be considering the size of the site at this early phase in the investigation. This is established as a maximum capacity, whereas the MC approach is to select the largest site found during the exercise and then assess for ‘commercial viability’.

3.1.1 Choosing Six Technical Criteria

There are a number of key criteria which generally fall under the description of ‘Technical’. These can broadly be grouped under the headings of topographic requirements (3), wind speed (1) and accessibility (2). These are described briefly
below and then summarised as a number (6) of criteria which are classified as Technical and must be included in the modelling.

Orientation.

In the South East coastal region the wind is predominantly from the South West, so before any coastal wind speeds are applied, a simple criteria will be applied.

- **Criteria 1 – The location must be facing the South West compass ‘Quadrant’**.

Although the Turbine Hubs can rotate to position the rotor blades into the wind, the optimum ground position of the turbines is dictated by the dominant wind direction. As this project will not be modelling the more complex on-site positioning, a generalised criteria is used. The remaining criteria constraints are chosen to represent the technical needs of the turbines, as they must operate at maximum potential output.

Slope.

A report examining the effect of various constraints on the total potential for wind energy in the UK, by The Energy Technology Support Unit (ETSU) states that, “…, high wind speeds occur in more complex terrain.” and the, “…strongest effect is due the variation in threshold slope.” The constraint used to define the technical requirement for slope is,

- **Criteria 2 – The slope of the site should be greater than 8 degrees but less than 15 degrees.**

This will place the site in a terrain range suitable for maximising the wind resource.

Elevation
As hub heights higher above ground level increases the resource considerably a complimentary constraint is that the elevation of the site should reflect the complexity of the terrain, with a minimum level set to force the site to be positioned higher up the landscape surface. This constraint will obviously depend in part on the relative height of the landscape but it is likely that one would need a minimum height of 50m to carry out the modelling.

- **Criteria 3 – Show all locations that are above 50m**

**Wind Speed**

A key criteria is the wind speed. Certain minimum average speeds are needed to justify the creation of a wind farm. It is essential therefore to use available estimates of wind speed to create a wind speed surface which can be queried at different heights. As stated previously the minimum average wind speeds needed to effectively justify a wind farm are around 6-7 metres per second. As these speeds are less likely to be found in the South East we can relax the criteria for modelling purposes and focus on sites that have a minimum wind speed of 5 metres per second. We will use the GIS and DTI Wind Speed Database to provide us with this information.

- **Criteria 4 – Show all locations with an average annual wind speed of greater 5 metres per second**

**Proximity to Road Network**

For technical and indeed commercial purposes, access to a road network is essential in Wind Farm modelling. This will generally mean that the site must be within a minimum distance from the national road network to allow for construction vehicles to enter the site and for delivery of materials and general access for supplies and staff. We will see later that under Environmental considerations proximity to built up areas may also be a deterrent. However as a technical criterion we need to specify a minimum distance to the road network.

- **Criteria 5 – Identify all sites which are no more than 500 metres from the minor road network.**
Proximity to National Grid

A crucial technical consideration is the need to link up our renewable energy source as much as possible into the existing energy network. There is some difficulty in identifying the precise location of the existing National Energy Grid. Such information is not readily available in digital form at the scale we will be working at. This is a situation, not uncommon in criteria modelling, where a proxy measure is used instead. Using the logic that existing power lines are linked closely with the main road network, we can identify a criteria based around proximity to major roads which effectively models proximity to the National Grid. This can be characterised as the following;

- Criteria 6 – Identify sites that are within 1 kilometre of the major road network and by extension existing energy/power networks

3.1.2. Choosing Environmental Criteria

There are other criteria which more specifically fall under the description ‘Environmental’. The BWEA lists a greater number of constraints in the landscape category for the developer to consider, but these are all environmental issues.

“The criteria we can consider for minimising environmental impact are of course very subjective, and will no doubt remain open to debate……there is no complete definition of all the discernible factors and suitable limits for exclusion zones.” (Anderson 1996)

This quote is useful in actually allowing us some scope in our modelling. When modifying our approach from the IC to MC this is more likely to be where changes are made and criteria are dropped.

These criteria can be grouped under headings of planning constraints (1), population safety (1) and environmental impacts (2) These are described below and then summarised as a further set (4) of criteria, classified as Environmental and which will be included in the modelling.
Planning Restrictions
The most significant constraints are that limited or no construction should take place within nationally designated nature and science protection areas. The list is quite large, and as this project is targeting the South East region, if all of the environmental impact issues were modelled and not challenged, there could be no sites created. Understandably, any developer considering the South-East as a target region would have to contend with a large number of landscape protection categories. For the purpose of this project, only one representative environmental constraint has been chosen.

- Criteria 7 – No sites shall be allowed within the boundaries of Sites of Special Scientific Interest (SSSI’s)

Population Safety & Impact
Safety is an obvious factor with exposed machinery, where proximity to large moving parts has the potential to cause serious injury and fatalities. It is suggested that Wind turbines should be greater than 500 metres from residential properties. This distance limits the risk of accident due to ‘blade throw’, where one of the Rotor blades from the turbine is sheared off during operation, becoming a lethal projectile. This recommended distance is for zero risk of injury in one thousand years from a 3MW Wind turbine. It has been adopted in the project as a suitable ‘risk-distance-diagram’ as 3 Megawatts output from one machine is currently the largest capacity available on the European market.

Additionally, Noise intrusion is a significant factor in the siting of a wind farm. The process of assessment of the noise has been carried out by the Netherlands Environment Agency, who have set a maximum emission level of 40decibels, based on average wind speeds as, “…the emission – level of the turbine and the level of the background noise vary with the windspeed.” The BWEA suggest that, “…the sound of a working wind farm is actually less than normal road traffic or an office” (BWEA 1994) and places the wind farm at 35-45 decibels (dB), between a quiet bedroom and a car travelling at 40mph at 100 metres away.
It is suggested that for both safety and low noise intrusion, a wind farm should be no less than 500 metres from any residential areas. In this study the distance buffer is eliminated, as the distance from dwellings for safety has already been established at 500 metres, so noise would not therefore be a significant issue. So Criteria 8 then becomes,

- **Criteria 8 – Identify all sites which are more than 500 metres from dwellings and built up areas.**

**Water Pollution**

As a potential variable affecting wind farm location, proximity to water courses is a minor if still relevant criterion. As well as lessening the risk of flooding of the wind farm during the winter and spring, it is important to keep the site and the various mechanical parts of the turbines away from water. For this reason and to lessen risk, albeit very minimal, of contamination to the water course from the wind farm, it is suggested a wind farm should be at least 200 metres distant from any water course. So in this case our next criteria, becomes,

- **Criteria 9 – Identify all sites more than 200 metres a river**

**Interference.**

The next set of considerations are also ‘interference’ based. These have been eliminated from the project as they do not present significant problems to the practicality of the installation. It has already been mentioned that the higher wind speeds are present at higher altitudes, but the turbines also require consistent wind speed, with little or no turbulence caused by surface roughness,

“The rougher the surface, the more the wind…is impeded,…Providing there are no obstacles (i.e., buildings, trees or hills), the wind speed at a given height is nearly the same over the entire area.” (Hunt 1981)
This invites a buffer zone from woodland, but the BWEA does not publish a recommended minimum distance. The New & Renewable Energy Bureau (ETSU) indicate that the buffer for woodland has been increased from 100 metres to 200 metres and above. To eliminate any possible interference from woodland, the criteria is therefore set initially at 250 metres. As the wind resource is a function of the terrain, elevation and slope, and an inspection of the Ordnance Survey map shows that there is very little woodland on the slopes of the South Downs, this criteria will not be modelled.

- **Criteria 10** - Identify all sites, which are a minimum of 250 metres from existing woodland.

**Summary of the Criteria to be applied in the initial model:**

The following is a summary of the main Technical and Environmental criteria which will be used in both the Initial Criteria IC and Modified Criteria MC approaches. There is no hard and fast rules on which of the IC will need to be dropped to carry out the MC approach. This flexibility is deliberately built in to the case study for a number of reasons;

1) As there is no limitation on the area chosen it may well be that the effect of using all 10 of the criteria in the initial IC will result in no sites being found at all. This is a distinct possibility in some parts of the country, especially low-lying areas. In these circumstances, it may be that quite a number of criteria will need to be dropped in the modified MC approach. Even then there is no guarantee that suitable sites will be found. In such a case, it is readily apparent that the chosen location is totally unsuitable for Wind Farm development.

2) By not specifying exact criteria in the MC approach, the student is enabled to experiment with the modelling to try and get around the ‘no sites found’ problem. They will also be asked to justify their decisions to drop certain criteria. The process of re-modelling will also show understanding of the processes of criteria modelling.
Criteria to be included in Initial Modelling (IC). Technical and Environmental criteria are marked in bold as T and E respectively.

- Criteria 1 (T) – Aspect - South Westerly (180-270 degrees)
- Criteria 2 (T) – Slope - Between 8 and 15 degrees
- Criteria 3 (T) – Height - over 50m
- Criteria 4 (T) – Wind Speed - greater than 5 metres per second
- Criteria 5 (T) – Access - no more than 500m from minor road
- Criteria 6 (T) – National Grid - within 1km of main road
- Criteria 7 (E) – SSSI - not in SSSI area
- Criteria 8 (E) – Population Impacts - at least 500m from urban area
- Criteria 9 (E) – Water Pollution - more than 200m from river
- Criteria 10 (E) – Interference - more than 250m from wood
3.2 Stage 2: Data Collection

We now know the principal sets of criteria which we need to apply. How do we now go about collecting the data for our chosen area to begin to model these processes. This is a major stage of any GIS project and this is no exception. The manual will lead you through some of the key datasets involved and through the process for a specific area in the South-East near Brighton & Hove. It is your task to replicate and even develop the process as you do the same modelling for a part of the South-East you are interested in. Remember you must pick an area which has a reasonable elevation i.e. a minimum of 50 metres. You will not be allowed to use the same area developed within this manual.

The other consideration at this point is to state that the data collection process will require different approaches and varied amounts of effort and time. This is also a point at which GIS skills will be used more closely to make the data match the GIS format. The Criteria will essentially fall into 3 main categories. These range from:

a) already created and available as shape files (Criteria 7)

b) Created by downloading and converting digital OS files from DIGIMAP and then developed through internal processing within ArcView (Criteria 1-3, 5-6, 8-10)

c) Created via an external programme. (Criteria 4)

It is fairly clear that those criteria in category a) will require little time or processing, while criteria falling into category b) will need more processing and more time. The final criterion, d) is likely to take the most time and will require a laborious data entry process as well as deepening one’s knowledge of the OS National Grid. Once entered into a format which can be read in a GIS it is a relatively quick process to create a wind speed surface.

Category a)

Criteria 7: SSSI’s are included on the CD/Disk for a selected block of the South-East. To download SSSI files for other parts of the country please visit the English Nature web-site, [http://www.english-nature.org.uk/pubs/gis/gis_register.asp](http://www.english-nature.org.uk/pubs/gis/gis_register.asp).
You will be expected to register with your name and academic user name and will then be free to download the relevant tiles you need. Note that the tiles are not immediately available in ArcView native format but must be converted from MapInfo or DWG format.

Category b)

The second key element in the data collection process is access to the University of Edinburgh's DIGIMAP site. As this case study is only available to registered institutions then you will be a student in a University that subscribes to the service. The service is a valuable agreement between subscribing Universities and the OS and gives you the ability to download all of the base digital topographic files you will need to carry out the GIS modelling. All individual students must be registered to use DIGIMAP. Without this registration it is impossible to carry out the case study. **PLEASE MAKE SURE YOU ARE REGISTERED.** We will assist you in this process at the start of the Case Study if required.

The next stage of data collection is to use DIGIMAP to download the specific digital tiles you want to build up the criteria. In the case study you will be asked to download and convert tiles for two separate OS digital products. These are:
1) Meridian 2 - a vector 1:50,000 scale dataset containing the main topographic layers you will need to create **Criteria 5, 6, 8, 9 and 10.**
2) Panorama - a raster 1:50,000 dataset which acts as a Digital Terrain Model (DTM) to allow you to model criteria linked to height, slope and aspect viz. **Criteria 1, 2 & 3.**

Downloading data from DIGIMAP is relatively straight-forward. What is a little more complex is the conversion of that downloaded digital file into a format that ArcView can understand. DIGIMAP provides files in a format known as National Transfer Format (NTF). This is a generic format which is not specific to any single GIS but requires a software-specific translation programme to convert into a format that the GIS can understand. This is because there are over 50 commercial GIS packages sold on the open market and it is not the OS's responsibility to make their data match every piece of software. Fortunately for the case study we have access to a programme
called MapManager6.2 which directly translates NTF files into native ArcView Shape files. Instructions on how to both download data and translate it from NTF to Shape file format are included in Appendix MM2 - Mini-Manual 2 and will be explained further in the next section.

Five of the criteria in this category are based on the digital layers downloaded and converted from DIGIMAP. As can be imagined, these criteria will require the use of the distance command on vector layers and then some raster querying to identify them. The first 3 criteria also demand the use of the Spatial Analyst extension. These are all processes which should be well within the scope of a second level GIS user.

Category c)

On your computer (or attached to WebSite/CD) is a zipped executable version of the ETSU NOABL Wind Speed Database. This is a free piece of software which is made available via the web and which students have full permission to use. The web-site from which it comes is listed in the Appendix. You will need this program to identify the data you need to create a wind speed surface for use in Criteria 4. This is a slow process which will involve a fair amount of manual processing as well as developing knowledge of the UK National Grid. We will only ask students to create a data set for 100 square kilometre area to minimise this amount of work though obviously developing data for a bigger area will aid in the siting process. It will involve using the Wind Speed Database to create a set of readings for 100 separate points with wind speeds at three separate heights 10m, 25m and 45m. It is also recommended that students extrapolate this data if they wish to model higher topography. The difficulty with the data is that it calculated from base surface level so working in the area we are in, with heights reaching 240 metres, will involve either assuming the same wind speeds at 50 and 250 meters or making an intelligent estimate of increased speeds on higher ground. This is explained in a little more detail in the manual in the Appendix MM1.
3.3 Stage 3: Data Collation

Category A

Downloaded and available shape file of SSSI’s of the South-East: SESSI. This will need to be converted to a GRID file to match the other criteria. In the case of this file this can be a little trickier than it looks as the key is to identify as a criteria only those areas which are not an SSSI and yet the vector file only shows those that are. The best thing to do is to do the same as in category B file (see below for an example) by creating a distance file and then finding all values that are greater than 0 (to bring us right to the edge of the SSSI areas). This gives you the theme for Criteria 7.

Category B

There are two main digital file types to be downloaded from DIGIMAP. The first of these will be Panorama tiles and the second, Meridian2 files. A set of tiles are suggested below for use in the workshops but remember you will have to select a different area when carrying out the case study yourself.

Panorama Tiles TQ20 and TQ40.

These can be downloaded as a zip file and then unzipped to produce NTF files. Panorama files are almost automatically converted within Map Manager (see Appendix MM2). The output will be in the form of 2 ASCII files – named TQ20.asc and TQ40.asc respectively. These can then be imported as data files (File> Import Data Source) and saved as two GRID raster layer within ArcView. By using the Grid Analyst extension (make sure this is ticked in the File > Extensions command) you can merge the two tiles using the Transform Grid > Merge command.

To generate the criteria from the merged DTM is a relatively simple process and should use existing knowledge of Spatial Analyst. This will create Criteria 1, 2 and 3 by querying the initial DTM as well as the derived Slope and Aspect layers. In the case of both slope and aspect you will need to use the Map Query option and, within
that, the Boolean AND box as this will allow you to type in the lower and upper boundary values i.e. greater than 8 and less than 15 degrees in the case of slope. From these you should be able to generate the layers for Criteria 1, Criteria 2 and Criteria 3.

Meridian2 Tiles TQ30, TQ31, TQ40 AND TQ41. These tiles must be downloaded from DIGIMAP and contain a number of relevant vector layers which can be subsequently converted using MapManager. For more detailed support please refer to the attached Mini-Manual 2. The key stage in converting the data is to use the pre-prepared Meridian Schema (datascm.smm). This has been set up on the disk and needs to be installed in the following sub-directory (C/ProgramFiles/MapMgr/) on your machine where it has not being pre-loaded. The output will actually be in a set of layers which includes (among several others you will not use) the 5 main themes you need for Criteria 5-6 and 7-10, i.e. main roads, minor roads, woods, built-up areas and rivers. A key stage in the conversion process is to merge the 4 different layers together. You can do this using the GeoProcessing wizard within ArcView but it is quicker and easier to do in Map Manager. The key step is to convert the files in MapManager, do not under any circumstances close any windows, and then run the Utilities > Append shape files. This will create a new folder called Appended in your working sub-directory and you will find all the 5 themes in there for the whole area (Mainrd, Minoroad, Urban, Water, Wood)

Having loaded up the layers from the converted Meridian tiles, it is now possible to run the Find Distance command to move towards creating some of the criteria you need. This manual will not spell out each one in turn but rather will describe a sample approach for one and let you work out the rest for yourselves.

EXAMPLE: In the case of Criteria 8, where you need to identify all sites which are at least 500m from an urban area you will initially need to make the Urban.shp layer active, run the Analysis > Find Distance command which will then create a distance layer. You will then need to query the resultant raster output layer to identify those locations which fit that specific criterion, via the command Analysis > Map Query > Distance to urban.shp >= 500. This produces a Boolean output file with two values,
0 and 1, with the latter identifying those areas which are suitable for a wind farm according to that criteria. You should name this file in the Theme > Properties box as **Criteria 8**. The other criteria which fall into this category can be modelled in a similar way, giving you the remaining vector-derived layers, **Criteria 5, Criteria 6, Criteria 9 and Criteria 10**.

**Category C**

Run the WIND SPEED programme the data to match the tiles you have already identified. This process is described in Mini-Manual MM1 which explains the way in which the data is stored and gives you guidance on the way in which you need to set up and store the raw data. You will later import this into the GIS as a point layer.

This is perhaps the trickiest data layer to create and will involve some basic data entry. Essentially you start by identifying an area you wish to get data for. We are using in this case a 10 X 10 kilometre area east of Brighton. We are restricting the area being modelled to this size as it will mean than the laborious semi-manual process of identifying and entering the wind speeds is minimised to 10 by 10 readings at three different heights.

As the manual suggests, the key is to identify the correct grid co-ordinate for the bottom left hand corner point and then work up from there. In the case of the ETSU NOABL database it needs to have the data as a simple x and y co-ordinate with the appropriate two-letter code in front, i.e. TQ3010. You will later need this as a 6 digit co-ordinate to import into ArcView but this will be simple to do. Start by typing in the two letter code for the 100km square block, in this case, TQ. This will automatically put the appropriate numbers in for OS x and y co-ordinates. Then enter the remaining two-digit numbers for the easting and northing, in this case, 30 and 10 respectively. You will notice that the right hand set of boxes has converted TQ3010 into the form 530, 110 which is what the programme understands. Then click on the blue button to the right. We are then presented with the wind speeds for that point plus those of the 8 points around it for all three heights in three separate grids. In this way the data can be entered more quickly. The key is to understand and get the co-ordinates right. You will then need to do this for each of the other co-ordinates in the grid but this is
simply a case of changing the references at the top and pressing the blue button again. This will appear very laborious but is perhaps intended as a lesson/Sisyphean task for all GIS users to show them the number of steps one has to go through to create clean data for the system when it is not already in GIS format.

Once the data is collected from the Wind Speed programme, it needs to be created in the following format as a simple x,y,z text file. This is where a simple multiplication of the co-ordinate column by 1,000 can be done to make it match the GIS.

<table>
<thead>
<tr>
<th>X co-ord</th>
<th>Y co-ord</th>
<th>Wind Speed at 10m</th>
<th>Wind Speed at 25m</th>
</tr>
</thead>
<tbody>
<tr>
<td>530,000</td>
<td>110,000</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>530,100</td>
<td>110,000</td>
<td>5.5</td>
<td>5.9</td>
</tr>
<tr>
<td>530,200</td>
<td>110,000</td>
<td>5.6</td>
<td>5.3</td>
</tr>
</tbody>
</table>

This can then be imported to ArcView using the Add Table option within the Project window and then running the **Edit > Add Event Theme** command. A previous version of the text file derived from the Wind Speed database for the chosen area has been set up called **Windv7.txt** and we will use this in the workshops. This will create a point file which then needs to be immediately converted to a shape file (**File > Convert to Shapefile**). We now have a point file in native ArcView format which can be interpolated using Spatial Analyst at each of the chosen heights. For example to create a surface from this point file the **Surface > Interpolate Points** command may be used with **IDW** method and selecting the appropriate z value for any one of the columns of data in the file. This creates the wind surface at that height and will provide us with a key criteria for subsequent modelling. By querying this resultant wind surface layer with Map Query we can finally create our final **Criteria 7.**
4. GIS Modelling and Analysis

We have now got the basic ingredients we need to pull the previously shape files and the previously described Criteria together to carry out the GIS modelling. You will need to construct slightly different data together for the TWO different modelling approaches in this Phase I. Your first step will be to do the INITIAL MODELLING (IC). You should have in place the core datasets that you need and will now carry out the GIS processing to enable you to model all the criteria you need within a GIS project.

For each of the criteria listed below there are some tips and hints on how to start to model them. As already stated the case study is not intended to be a simple step-by-step guide. Second-level GIS students will be expected to have a basic grasp of the software and the data. This is also an assessed piece of work and as such students will be expected to demonstrate a basic grasp of GIS principles and a sound understanding of the data you are working with. This will be apparent in the way in which you put the datasets together and how you develop and model your criteria. This will also test your project management skills and how well you understand the task set before you.

Phase I: Initial and Modified Modelling

INITIAL CRITERIA MODELLING (IC)

You now have gathered 10 criteria together for the modelling. Again we will not be spoon-feeding but suggest to you that the different criteria should all be in a single format - raster - which will make modelling all of the criteria together a simpler process. This should be the case anyway if you have used Map Query and set up the criteria correctly. You should be careful to re-name as you go along especially as you are working with a great deal more than 10 files. This is especially important when using the Map Query and Map Calculator commands as they tend to rename things by just adding a version number to the end.
**Hint** - you can laboriously multiply each criteria one after the other but there is also an option in Map Calculator of multiplying them all together. This is one advantage of using Map Query when you are actually setting the criteria up. By going into Map Calculator you can click on the first criteria on the list. Double click on this and then double click on the multiply icon ( \( \times \) ) and then select the other criteria in turn clicking on the multiply button after each one. This will then run all the criteria together and produce a result of your initial modelling.

You should now convert the results of your modelling into a vector format and label it **IC.shp**. This is then ready for some subsequent modelling which will be carried out in Phase 2

**MODIFIED CRITERIA MODELLING (MC)**

Having carried out the initial modelling we can see that there are a relatively small number of available sites. It may well be that when you carry out your own project, that no sites are identified at all. You might decide that, within reason, you can relax this initial approach. You can do this in a number of ways, as outlined below, but whatever you decide, you must justify and explain why you made these choices. The coherence and common sense and understanding of the problem will be contained within this explanation and will form an important element of the assessment as the approach you take will also show your knowledge of the GIS processes you have just carried out.

2 main approaches are suggested to creating and running the Modified Criteria (MC);

The first is simply to drop a number of the criteria. By modifying the process you will inevitable come up with a different result. You may choose to drop anything from 1 to 4 criteria but whatever you do must be explained and justified. It is not recommended to drop any more than four criteria and indeed you will have four times the work justifying their demotion.
A second approach and one that may be easier to explain and rationalise is to re-visit the specific values within one or more of the criteria. As an example, if you wished to modify Criteria 2, Slopes, then you might choose to broaden the slope range to pick up a bigger area. This could be done by re-modelling, in the example here, the criteria for slope as now being Greater then 5 degrees and Less than 20 degrees (rather than the >8 and <15 previously used). However this would have to be justified again.

The MC component of the project is an interesting one and we would recommend that you experiment. You may find that by narrowing one criteria and expanding another that you get a similar result. Or it might be that by relaxing the criteria you open up a number of new potential sites. There are no set rules on what results you will get and again, it is the process and the understanding of that process that matters. It is unlikely however that by relaxing 3 or 4 of the criteria, you will identify a smaller number of sites and this should give you more to play with in the final phase of the exercise.

You can now use the Map Calculator to multiply your modified criteria together. You may find it helpful as you go through to re-label the revised version of any one criterion as Criteria5a, where you have updated the previous layer, Criteria5. Make sure you use the revised version when modelling all the criteria together. The resulting shape file from this modified process can be labelled **MC.shp**.

In this example we have taken the step of changing the slope specifications (Criteria 2) as listed above and also extended the distance used in Criteria 6 to 1.5 kilometres. We have also excluded woodland (Criteria 10) as there is not many large areas of woodland near our area. This means that the MC approach uses Criteria 1,3,4,5,7,8,9 and new Criteria 2a and 6a.

You will now have finished **Phase I** of the project and we will now take our identified sites from both the IC and MC approaches forward to the final section of the project.
4.1 Final Technical Modelling - Phase II

The initial modelling phase having been carried through, we now need to carry out a further modelling, a **Phase II** in effect which will model some additional specific requirements for a wind farm. We will also introduce a secondary environmental impact element by looking at visual effects and population affected to further clarify and complete the siting process.

You will now have now identified a number of sites from our combined IC and MC modelling. There are a further series of criteria we need to incorporate in Phase II.

**Area (Criteria 11)**

We have identified a number of sites. Obviously not all of these will be big enough to house a wind farm, while other sites will be far too large for the energy output required. We therefore need to identify (in the sample case study) those sites from both IC.shp and MC.shp are larger than 25,000 square metres and smaller than 150,000 square metres (or if you prefer between 2.5 and 15 hectares). It is likely that the minimum size will be more relevant than the maximum size. Also these limits may change depending on where you are working so if there are problems with the data, then a possible second option would be to pick the 4 largest sites found under both approaches.

This process will require us to convert the result file containing the sites from a raster to a vector format (if this has not been already done). We will now have a set of vector polygons but how do we know the area of those polygons? To find this out we need to run an ArcView script (called calcarea - included with the pack) to estimate the area of the sites and then run a query to identify those within the specified range. Again there is a presumption that students will have some knowledge of scripting but as an aide memoire, the key stages are to go to the project window, click on the script icon and then click on new. A script window appears and you should run the **Script > Load text file** command and choose calcarea. You then compile the script by clicking on the tick icon. You then click on the view window and then go back to the script window and run the script by clicking on the running man. We then have the data we
need in the table file associated with the sites to do a minimum and maximum size query.

**Environmental Impact**
A further consideration, in part incorporated in the Environmental criteria already used, is the visual impact of the wind farm. Wind farms with turbines of up to 70 metres in height will be visible from a long way away. It is important therefore, to minimise this visual impact. There is a free extension, Viewshed\(^1\) which is specifically designed to identify areas from which specific elements in the landscape can be seen. When you load it up from the file >extensions area you will see two new icons just above the View window which look like an hourglass and a pair of binoculars.

This extension can be run from the mid points of the sites identified as being of the right size (generally by using the highest point on the site as a marker and using that height as the starting point for the viewshed modelling). You will need to use the original merged height file as your base. After clicking on the Binoculars Icon, you will be asked for some options. It is recommended that you set the tower height to 70m (the average size of a modern turbine), the offset height to 5m, the field of vision to 359 and make sure the far distance is at least 5000m. You then point and click in the centre of the site, holding the mouse button down. Draw a line out in any direction, preferably south-west, let go of the mouse button, and the visibility extension will run. This creates a polygon which shows the area from which the tower can be seen, its viewshed in effect. The polygons created (one for each of the 4 sites in both IC and MC) will need to be saved as shape files for the next stage of the modelling.

**Population affected**
While it is one thing to see the areas from which the wind farm can be modelled, it would also be useful to identify the populations affected within this area. We have attached a ward map with basic population information for the whole of the south east (Wardseast.shp). By taking each of the sites in turn it should be possible to cookie-

---
\(^1\) If looking for the script it is in C:\ESRI\AV_GIS30\ARCVIEW\SAMPLES\ext\vistools.avx
cut using the Geo-Processing extension and identify from the table the populations which fall within the viewshed areas for each site. You will have to run a vector query on the viewshed file to find all those areas where Gridcode = 1 and convert this to a shapefile. You can then run this through the View > GeoProcessing > Intersect two themes option choosing the selected site theme and Wardseast theme. The resultant intersect file (you should name it within the GeoProcessing wizard) will have a Pop Column which you can select and then get a sum of the population affected by using the Field > Statistics option. This will be one of the outputs to your final table.

**WARNING** - when you look at the intersected file, check carefully for duplicates which are bound to appear. This will affect the total population figure. There are two ways of managing this problem. 1) The first approach is to use the GeoProcessing wizard. Select the top option Dissolve feature based on attribute. Choose Name as the attribute to dissolve and when requested by the wizard, select 'pop by average' as the field/option to be included in the output file. This will average the population values for all the duplicate records. When finished identify the total population of the affected area from the table (select column name pop and choose field > statistics)

2) The second approach is to put the table in edit mode, select the duplicate rows (shift click) and delete them (delete records). When finished identify the total population of the affected area from the table (select column name pop and choose field > statistics)

*Final Choice of Site*

Just when you though it was all over, the final stage of the whole process is to take a measure of the detailed wind speeds at the chosen sites to clarify and compare their suitability for a wind farm. This will essentially involve identifying the minimum and maximum wind speeds (generally found at the lowest and highest points) of each site as well as estimating the average wind speed and comparing these to a table of the population affected. In this way it should be possible to identify maximum potential power input combined with minimum impact and in effect, identify (and justify) our optimal site from the 8 we have identified under both MC and IC.
You will hopefully still have a copy of the Wind Speed surface layer you have created and you can overlay this with the vector sites files (IC.shp and MC.shp). Make the vector layer (IC or MC) active and choose one of the sites by using the select feature icon and drawing a box around it. Now make the raster wind speed surface layer active. Choose the drop down command Grid Analyst > Extract grid theme using polygon. Choose the next fault and then choose the chosen vector layer i.e. IC.shp as the polygon layer to be used. Choose the remaining default and you will be presented with a new raster grid file drawn around the chosen site. Make that layer active and then choose the command Grid Analyst > Calculates statistics of a grid theme. From this you can glean the mean, minimum and maximum wind speeds within that site.

Below is a pre-prepared table with those values as well as a data on the population affected. You will be expected to come up with something similar when you carry out the project yourself. Looking at the respective results, you might decide that for the IC modelling, the fourth site 4 (IC), has the highest average wind speed. This would suggest maximum power output (though this is tempered by the size of the site - perhaps another measurement you could work with) along with the smallest visual impact on local populations which makes it the best site. For the MC modelling the sites are bigger and higher and have higher wind speeds. Those close to town 1 (MC) and 4 (MC) have high scores for population affected, whereas 2 (MC) and 3 (MC) are a better balance. Again it would be a close choice with perhaps site 3 (MC) having the edge due to slightly higher wind speeds. Interestingly both of the chosen sites from each approach, IC and MC are very close together suggesting that across the board these sets of sites near Lewes will be the optimum location with 3 (MC) being the best location across the board.

Table 1a. Results for IC Modelling of Wind Farm Sites

<table>
<thead>
<tr>
<th>Site</th>
<th>Size (ha)</th>
<th>Min Speed</th>
<th>Max Speed</th>
<th>Ave. Speed Site Centre</th>
<th>Pop Affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (IC)</td>
<td>3.85</td>
<td>6.15</td>
<td>6.29</td>
<td>6.24</td>
<td>63,105</td>
</tr>
<tr>
<td>2 (IC)</td>
<td>10.68</td>
<td>5.74</td>
<td>6.12</td>
<td>6.01</td>
<td>59,011</td>
</tr>
<tr>
<td>3 (IC)</td>
<td>3.82</td>
<td>5.86</td>
<td>6.03</td>
<td>5.96</td>
<td>60,765</td>
</tr>
<tr>
<td>4 (IC)</td>
<td>4.37</td>
<td>6.29</td>
<td>6.52</td>
<td>6.34</td>
<td>24,420</td>
</tr>
</tbody>
</table>
Table 1b. Results for MC Modelling of Wind Farm Sites

<table>
<thead>
<tr>
<th>Site</th>
<th>Size (ha)</th>
<th>Min Speed</th>
<th>Max Speed</th>
<th>Ave. Speed Site Centre</th>
<th>Pop Affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (MC)</td>
<td>13.22</td>
<td>6.75</td>
<td>7.14</td>
<td>6.86</td>
<td>129,680</td>
</tr>
<tr>
<td>2 (MC)</td>
<td>11.35</td>
<td>6.29</td>
<td>6.61</td>
<td>6.42</td>
<td>24,420</td>
</tr>
<tr>
<td>3 (MC)</td>
<td>8.23</td>
<td>6.22</td>
<td>6.86</td>
<td>6.56</td>
<td>26,136</td>
</tr>
<tr>
<td>4 (MC)</td>
<td>11.11</td>
<td>6.66</td>
<td>6.89</td>
<td>6.74</td>
<td>115,320</td>
</tr>
</tbody>
</table>
5. Results & Outcomes.

You have now worked your way, laboriously or otherwise through the different criteria to come up with an initial set of 4 sites for your wind farm (IC). You have further developed this process through the additional modelling to identify 4 further sites (MC) which fit the environmental, planning and technical concerns of all interested parties. Your final task is to write a Site Suitability report with additional cartographic, statistical and tabular outcomes to present to a fictional planning committee in the local area where you have worked.

The written report does not have to be of great length. We recommend a length of around 1,500 -2,000 words. This report will explain the context and location of the work, the criteria chosen initially and where relevant modified. You will then explain the GIS modelling you carried out to show how you identified the final 4 sites for both IC and MC approaches. You may use a flow-chart if you wish as this may summarise the process succinctly for the reviewer. You would also be expected to illustrate the chosen sites in a number of printed maps (following correct cartographic principles) and provide a final table which explains the potential impacts of the chosen sites to assist in further decision-making. For checking purposes you will also be expected to include three key themes on a disk with your submission, viz. IC, MC and the windspeed text file you created. (remember to include all three .shp, .dbf and .shx files)

This summary may help you by providing a check-list of final requirements:

- 1,500 - 2,000 word Summary Report incorporating;
  - Maps of Identified Sites (both IC and MC approaches).
  - Table of all viable sites (IC and MC) with the following;
    - Areas of each site
    - Populations visually affected by different locations
    - Minimum, maximum and average wind speeds for selected sites
  - Suggested and Justified Final Site from the 4 IC and 4MC sites.
  - IC, MC (both shape files) and Windspeed text file.
Maps should preferably be printed from layouts. Where printing is difficult, you can save them as JPEG files from the layout and incorporate them with the final report. Tabular output is difficult to manage within ArcView and may need to be created within a spreadsheet programme. Alternatively the table options within word processing programmes can also produce good quality outputs.

**Future development of case study**

The Case Study is intended to be a sample application using some very simplified criteria. It would not stand up to detailed technical scrutiny in the Wind Energy field however it could be developed in the future to make it a little more robust. This would involve finding out more about the technical specifications of different wind turbine models and looking at their suitability to the identified sites. This might be in relation to the minimum site sized needed, needs for specific minimum and indeed maximum wind speeds (turbines have been known to fall over in very big winds) and power outputs based on the number of turbines which can be fitted in the site. It is also likely that there are a number of important criteria missing such as proximity to ridge-lines (wind speeds become erratic on the 'back' side of a mountain) and closeness to the sea (higher wind speeds and lesser interference). Some of these criteria could be identified from the technical literature and added to develop the model further.

Additionally, the demographic side of the model could be developed to look at the number of homes served in the vicinity of each site. In this way the practical local benefits to the power supply chain could be measured. This would involve only adding a small amount of additional data (essentially a column with numbers of households) to the ward map and then running a distance command and subsequent geo-processing intersect for each site to identify how many households fall within a specified distance of each site. This has not been included at this stage as it remains to be seen how the project works out in the classroom environment and whether it will need a greater or lesser input for optimal student educational benefit.
References & Resources

Resources

http://www.windpower.org/
Website of the Danish Wind Industry Association (2001)

http://www.britishwindenergy.co.uk/noabl/
Website of the British Wind Energy Association and on-line address for Wind Speed Programme

http://www.english-nature.org.uk/pubs/gis/gis_register.asp
Website of English Nature containing access to free maps of SSSI's. These are in a number of different formats, mostly linked to MapInfo and DXF.

References


Appendices

Mini-Manuals

MM1. ETSU NOABL WIND-SPEED DATA. Saving and Converting.

MM2. DIGIMAP DATA DOWNLOAD and Converting NTF Files with MapManager 6.2